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Introduction 
 
Welcome to Cricket v2!  
 
Cricket v2 has been designed from the ground up to offer a great flexibility 
and intuitiveness to designing and performing your sound for a show--
whether it be live theater or any other environment where you are called 
upon to perform your sound with precision.  
 
Sound Design for theater has come a long way in the past ten years, with 
computer-based systems becoming more prevalent and digital sound in 
general making leaps and bounds in sophistication of design and 
presentation.  The new generation of audiences and artists of theater have 
grown up with film sound and more recently home surround sound for video 
games, DVDs and television.  People expect more of sound in theater than 
they used to (even if the respect for sound in theater is still somewhat 
shortcoming).  I hope that Cricket v2 will help make sophisticated theater 
sound design easier to achieve. 
 
Use Cricket in rehearsals to help make design choices and to more fully 
integrate sound into the rehearsal process.  Then, if you use Cricket in the 
theater, much of the groundwork will have already been laid.  Even if you 
transfer the show to a different or bigger system in the theater, using 
Cricket in rehearsals will make that transition as smooth as possible—
giving you a starting place for levels, timings, and Q structure. 
 
Whether you are brand new to computer-based audio, or you are a veteran 
of Cricket v1, I suggest you read through the manual, or at the very least—
take a look at the Cricket 2 System Flowchart and the Timeline of a Q 
Parts One & Two.  These three pages are a good place to start learning 
the structure and concepts of Cricket v2, and it won’t be long before you 
will be building Qs, looping Tracks, and mapping Matrices. 
 
Have fun! 
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Installing Cricket 
 
Run the package installer to install the application, documentation, and all 
necessary support files.  The latest version of the installer can always be 
found at cricketsound.com. It is recommended that you install the Cricket 
application directly inside the Applications folder, although you can choose 
to select a different location if you prefer.  All documentation is installed into 
the Documents folder. The installer includes a fresh set of Q Templates 
and Default Files, so if you are updating to a new version of Cricket 2 and 
wish to maintain your old Q Templates and Default Files, be sure to choose 
Custom Install and deselect these from the installation. 
 
Authorization 
 
If you are running Cricket for the first time, you will see an Authorization 
request screen.  You can choose to ignore this screen and run Cricket in 
demo mode.  In demo mode, all save and load functions are disabled, but 
the application is fully functional apart from that, so you can test out all of 
Cricket’s audio and Q-building capabilities.  If you want to purchase a 
license, go to cricketsound.com and follow the links.  After purchasing, you 
will receive a confirmation email with a registration number that you can 
use whenever making authorization requests or any registration inquiries. 
In the Authorization request screen, you will see a series of numbers and 
letters in a gray field that serves as your authorization code.  Copy these 
letters/numbers down exactly as they appear and send an authorization 
request along with your registration number to unlock@cricketsound.com.   
 
For each license purchased, you receive 2 ‘roaming’ authorization slots.  
That means you can install and authorize Cricket on 2 separate machines 
concurrently, with the ability to de-authorize and re-authorize at any time.  
In the file menu, you will find a De-Authorization function that you can use 
to De-Authorize a particular install of Cricket.  Once you run De-Authorize 
and confirm the request, a text file will be generated with a De-
Authorization code that you can send to unlock@cricketsound.com to free 
up a particular authorization slot.  This way you can authorize Cricket 2 on 
a machine for the run of a show and de-authorize it when the show is done. 
 
Please allow 24 hours response time for any authorization request.   
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Cricket Sound:  The System 
 
Audio Setup 
 
The first place to start in Cricket is the Preferences window where you will 
find the Audio Setup and System Setup panels.  You will find the 
Preferences window in the Options menu and can also call it to the front by 
clicking in the Show Panel display fields for # of Ins/Outs/Decks.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Audio Tab to choose your Audio Driver settings.  
 
The Audio Driver menu will auto-populate with any coreaudio drivers 
installed on your system or you can choose the built-in audio.   
 
You can select a different Input Device than the default set with your 
chosen Audio Driver in the Input Device menu.  It is generally 
recommended for stability to use the same Input device as Output device, 
or if you are using OS 10.4 or later, to build an Aggregate Device in OS X’s 
Audio/Midi Setup utility if you want to virtually gang several different audio 
devices together.   
 
Choose an audio Sampling Rate to work in based on those available to 
your chosen Audio Driver.  Note:  The higher the sampling rate you work in, 
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the more CPU will be consumed by the audio engine.  In general, working 
in 96k sample rate is approximately 2X the CPU consumption of working in 
48k, etc. 
 
The I/O Vector Size and Signal Vector Size are the application’s audio 
buffer settings.  The I/O Vector Size is directly responsible for buffering 
audio in Cricket before it reaches your audio hardware.  The smaller the 
setting here, the less latency the Cricket application will introduce into your 
audio stream.  However, a smaller buffer will take higher CPU to manage.  
Generally, you will want to set this to as low a setting as your CPU will 
handle.  If you start to hear unexpected clicks and pops in your audio, this 
is usually caused by CPU strain and setting the I/O Vector Size to a higher 
value will help to relieve that.  Many audio devices will default to a setting of 
512K and that may be sufficient for most uses.  The Signal Vector Size 
reflects a secondary application-internal (and less critical) audio buffer.  
This can be set much lower than the I/O Vector Size (usually a setting of 
64K is sufficient).  Again, however, if you are having trouble with CPU 
strain, and are raising the I/O Vector Size, you may want to experiment with 
higher Signal Vector Size settings as well. 
 
Altivec Optimization should be turned on if you are using a G4 or later 
model Macintosh and turned off if you are using a G3 model.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 You must build a system before you can make any sound in Cricket! 



 7 

 
System Setup/Building the System 
 
 
After you have chosen and set up your Audio Driver, click on the System 
tab of the Preferences Window to set up your Cricket system.   
 
Here you can choose the number of Outputs, Inputs, and Decks you wish 
your system to be comprised of. 
 
Outputs and Inputs are downward-scalable from the maximum allowed by 
your audio hardware.  In other words, although your audio hardware has 24 
analog ins and 24 analog outs, you can choose to build a system with only 
2 Outputs and no Inputs in order to conserve CPU.  The more Outputs and 
Inputs in your system the higher your DSP CPU Usage will be.  Cricket will 
allow a maximum of 128 Inputs and Outputs (although its highly unlikely 
current CPUs would handle that load!) 
 
You can build a system with up to 64 stereo Decks to handle playback of 
tracks.  Again, the more Decks you have built in a system, the higher the 
CPU load will be (although the strain is less evident than adding more 
Inputs and Outputs).   
 
When you have chosen the amount of Outputs, Inputs, and Decks, click on 
BUILD SYSTEM to allow Cricket to virtually wire up your new system. This 
will take a few seconds, and when finished, you will find your requested 
Outputs in the Output Master window with a virtual set of Outputs in the 
Matrix Mapper, your Inputs in the Input Master window, and your Decks in 
the Deck Rack.  The System Setup panel should read ‘System is currently 
ONLINE’ and you should see some reflection of the DSP CPU load your 
system is generating.  Note:  This is only a reflection of the DSP CPU load, 
GUI and other calculations outside of the audio realm are not reflected 
here. 
 
Once you have built a system, you can always change the amount of 
Inputs, Outputs, and Decks and re-build the system again.  Note, however 
that any Qs you have built that rely on Inputs, Outputs, or Decks that are no 
longer available will need to be revised.  
 
System settings are saved into a Show File.  When you load a Show, the 
System will build as saved immediately after all Tracks are loaded. 
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Input Master (Tools Menu/CMD-6) 
 
The Input Master is where you will find the Inputs built in your system.  
These Inputs correspond directly with the physical inputs on your audio 
hardware.  If this window is empty—it is either because you have built a 
system with no Inputs or because you have not built a system at all yet.  Go 
to Options>Preferences>System to build your system.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Each of the Input 
Channels is equipped with 
a level meter that is post-
fader displaying relative 
db levels.   
 
Below the meter is a 
button to turn on/off and 
display the channel’s 5-
band EQ.  The Input EQ is 
turned off by default and 
should display a blurry EQ 
next to a pale toggle 
button.  Click on the 
toggle to turn on the EQ 
(which should now 
sharpen focus) and click 
on the EQ button to edit 
the Input EQ for that 
Channel.  Input EQ 
settings are saved with a 
show file.  See the next 
section for more on 
Cricket’s 5-band EQ. 
Turning off all 
unnecessary EQs will help 
conserve CPU. 
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The fader is a high-resolution logarithmic fader with levels in relative db 
extending from –77 (full out) to +17.2 spread across 600 values for 
maximum control of volume.  Manually grab a fader like a hardware mixer 
or click anywhere in the fader range to instantly jump the fader to that 
position.  Db values are displayed in the number box below the fader.  
Additionally, you can set levels by clicking and dragging in the db display 
box or by typing a new level value in the box.  Next to the fader are level 
markers that can also be clicked on to set the fader to that level.   
 
Below the db level display box is the Input Delay setting.  Input Delays are 
turned off by default and can be turned on by clicking on the Toggle button 
to the right of the Delay display.  Set an input Delay (calculated in seconds) 
here.  Turning off all unnecessary Delays will help conserve CPU. 
 
Mute and Solo buttons are marked with M and S respectively.  Mute will 
mute an individual channel.  Solo will mute all other channels while allowing 
audio from just the one channel. 
 
Below the Input Channel label (Input 1, Input 2, etc.) is the Input Assign 
menu where you can select what Mixer channel an Input will route to.  You 
can choose any of the 32 Mixer Channels available or select OFF to turn 
off audio routing of an Input.  Upon first building a system—all Input 
Channels are set to OFF in order to prevent any accidental feedback.   
 
Input Fader level, Mute, Solo, EQ settings, and Delay settings all save into 
a Show File.   When you load a previously saved show—these settings will 
load in immediately after the system is built.  If you rebuild the system at 
any point, Cricket will attempt to retain any Input Master settings that are 
still applicable. 
 
Input Assigns do not save with a show, but rather are assigned in a Q with 
the Input Assign Q Module.  (see Cricket Qs) 
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Master EQ (Input/Output Master) 
 
Cricket master EQs can be found on each Input and each Output built in 
your system.  The EQs can be turned on or off in order to manage CPU 
expense with each EQ switched off initially by default.  Turn an EQ ON by 
clicking the toggle button next to the blurred EQ switch on a master 
channel strip.  Then click on the (now focused) EQ switch to bring the EQ 
to the front.   
 
The EQ is a 5-band graphic EQ with control of Frequency, Gain, and Q, 
and a selection of nine different types of EQ for each band. 
 
You can set values by typing/clicking in the number boxes for each 
parameter, or by editing the EQ graphically.  Select a band by clicking on 
one of the 5 shaded areas in the display.  Click and drag left and right on a 
band to adjust Frequency.  Click and drag up and down on a band to adjust 
Gain.  Click on a band’s border and drag left and right to adjust the Q or 
bandwidth of the EQ.  Changing the EQ type will affect how these 
parameters apply to a band.  
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You can copy EQ settings and paste into any other Master EQ for 
convenience.  Additionally, you can save and load EQ settings as a 
separate preset file in order to store favorite settings to load into future 
shows. 
 
All EQ settings are saved into a Show file and are loaded in immediately 
after the show’s system is built. 
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Deck Rack (Tools Menu/CMD-1) 
 
The Deck Rack is where you will find all the Decks you have built in your 
system, and thus is the heart of the playback engine in Cricket. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Deck Rack will contain as many stereo playback decks as built in your 
system (from 0-64).  For more on Decks and playback, see the section on 
Audio Tracks. 
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Mixer32 (Tools Menu/CMD-5) 
 
Mixer32 is the hardwired central hub of Cricket 2’s audio engine.  All sound 
is routed through Mixer32 before being matrixed out to the Output Master.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Each of the 32 Channels is equipped with a level meter that is post-fader 
displaying relative db levels.   
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Below the meter is the channel’s Fast Fade button (marked FF).  Hit the 
channel’s Fast Fade button to instantly advance the fader to its final 
destination when it is in mid-fade called from a Q.  For instance, if you have 
called a Q to fade ch 1 from –77 to 0 in 40 seconds, hitting Fast Fade will 
instantly advance the fader to 0.  CMD-F will Fast Fade all Mixer Channels. 
 
The fader itself is a high-resolution logarithmic fader with levels in relative 
db extending from –77 (full out) to +17.2 spread across 600 values for 
maximum control of volume.  Manually grab a fader like a hardware mixer 
or click anywhere in the fader range to instantly jump the fader to that 
position.  Db values are displayed in the number box below the fader.  
Additionally, you can set levels by clicking and dragging in the db display 
box or by typing a new level value in the box.  Next to the fader are level 
markers that can also be clicked on to set the fader to that level.   
 
Below the db level display box are 3 buttons displaying what fade type the 
channel is set to.  
 
Mute and Solo buttons are marked with M and S respectively.  Mute will 
mute an individual channel.  Solo will mute all other channels while allowing 
audio from just the one channel. 
 
Below the channel label (Ch 1, Ch 2, etc.) is the Map List.  The Map List in 
Mixer32 is always populated with Bus 1-8 and any Maps that are currently 
built/loaded in the Matrix Mapper.  Here you can choose and display the 
Map assigned to the channel which corresponds to the channel’s routing 
out to the Output Master and in turn your audio hardware’s physical 
outputs. 
 
The Link buttons at the bottom of the mixer panel links together channels in 
stereo pairs (1+2, 3+4, etc.).  When Link is on, the odd channel will control 
the even channel, so you can grab and set levels on channel 1, and 
channel 2 will follow in suit.  Stereo Link is on by default. 
 
 
 
 
 
 
 
 
 

 
Mix Master (Tools Menu/CMD-8) 
 
The Mix Master controls the master volume of Mixer32 
before it is matrixed out to the Output Master or to the 8Bus 
master.  It functions identically to other faders in Cricket 
including mute control and settings are saved in a show file 
akin to the Input and Output Masters.  You can use the 
Control Builder to have midi control over the fader and mute 
button. 
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Matrix Mapper (Tools Menu) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Matrix Mapper is a panel of virtual Output Master faders that you can 
use to design Matrix Maps to route audio from Mixer32 or 8Bus channels to 
the Output Master. 
 
If the Matrix Mapper is empty, you need to build a system with Outputs.   
 
A Matrix Map is designed for single channel use, meaning that any Mixer32 
channel or 8Bus channel can be assigned to one Matrix Map at a time, with 
the ability to pan between Maps in a Q using a Map Assign Q Module.   
 
A mixer channel assigned to the above map would send audio to the 6 
outputs at levels designated by the map, however, you should think of 
the Matrix Mapper not as a tool to set volume levels, but as a tool to 
design templates for spatial placement of audio. 
 
If you are working with stereo audio tracks routed into a pair of Mixer32 
channels, you will probably want to create stereo pairs of Matrix Maps.  
Above is an example of a map called ‘Full Left’ making use of outputs 1, 3, 
and 5 of a 6-output system.  Let’s assume that outputs 1, 3, 5 are 
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connected to speakers on the left side of a house, and outputs 2, 4, 6 are 
connected to speakers on the right side of a house.  We would then want to 
create a mirror image of this Matrix Map by setting outputs 1, 3, and 5 to –
77, and setting output 2 to 0., output 4 to –6., and output 6 to –12.  We 
would then type the name Full Right into the Map Name field and hit Store 
Map.  You can then assign Full Left to the left side of a stereo pair of 
Mixer32 channels, and Full Right to the right side. 
 
 
 
 
 
 
 
 
 
 
 
Any maps you build and store in the Matrix Mapper will appear in Map Lists 
throughout Cricket and will be available for assignment.  To view a map, 
select it from the Map List drop-down selector and the virtual faders will 
populate with the stored levels from the map.  If you make any changes to 
the map, hit Store Map again to capture the changes.  If you wish to 
remove a map from the list, select the map from the map list and hit 
Remove Map.   
  
The Map List is actually one of four specially-formatted files that Cricket 
saves Show information into.  When you save a show for the first time, the 
Map List file is created with the name ‘yourshowMAPS’ and placed inside a 
newly created folder called ‘yourshow.crick’.  Each subsequent time you 
save the Show file (File>Save or CMD-S), the Map List file is also saved 
(as well as the Track List and any open Q Lists).  When you open the Show 
file, the associated Map List is opened and loaded into RAM. 
 
Additionally, you can save and load Map Lists individually, separate from 
the saving and loading of a Show file.  The drop-down menu on the Matrix 
Mapper has options to Load Map List, Save Map List, Save Map List as…, 
and Clear Map List. Clear Map List will erase all maps from the Map List, 
and you will be prompted for confirmation before Cricket executes the 
clear. 
 
 

Mixer Ch 1 & 2 are assigned to the two Matrix Maps ‘Full Left’ & ‘Full Right’. Any audio routed 
through Ch 1&2 will be matrixed to the Output Master to as designated in the maps we built. 
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Output Master (Tools Menu/CMD-7) 
 
The Output Master is where you will find the Outputs built in your system.  
These Outputs correspond directly with the physical outputs on your audio 
hardware.  If this window is empty—it is either because you have built a 
system with no Outputs or because you have not built a system at all yet.  
Go to Options>Preferences>System to build your system.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Each of the Output Channels is equipped with a level meter that is post-
fader displaying relative db levels.   
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Below the meter is a button to turn on/off and display the channel’s 5-band 
EQ.  The Output EQ is turned off by default and should display a blurry EQ 
next to a pale toggle button.  Click on the toggle to turn on the EQ (which 
should now sharpen focus) and click on the EQ button to edit the Output 
EQ for that Channel.  Output EQ settings are saved with a show file.  See 
Section G for more on Cricket’s 5-band EQ.  Turning off all unnecessary 
EQs will help conserve CPU. 
 
The fader is a high-resolution logarithmic fader with levels in relative db 
extending from –77 (full out) to +17.2 spread across 600 values for 
maximum control of volume.  Manually grab a fader like a hardware mixer 
or click anywhere in the fader range to instantly jump the fader to that 
position.  Db values are displayed in the number box below the fader.  
Additionally, you can set levels by clicking and dragging in the db display 
box or by typing a new level value in the box.  Next to the fader are level 
markers that can also be clicked on to set the fader to that level.   
 
Below the db level display box is the Output Delay setting.  Output Delays 
are turned off by default and can be turned on by clicking on the Toggle 
button to the right of the Delay display.  Set an Output Delay (calculated in 
seconds) here.  Turning off all unnecessary Delays will help conserve CPU. 
 
Mute and Solo buttons are marked with M and S respectively.  Mute will 
mute an individual channel.  Solo will mute all other channels while allowing 
audio from just the one channel. 
 
Output Fader level, Mute, Solo, EQ settings, and Delay settings all save 
into a Show File.   When you load a previously saved show—these settings 
will load in immediately after the system is built.  If you rebuild the system 
at any point, Cricket will attempt to retain any Output Master settings that 
are still applicable. 
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Cricket Sound:  Audio Tracks 
 
Track Loader (Tools Menu/Track Menu/CMD-2) 
 
The Track Loader is where you manage your Track List in Cricket.  
 
 
 
 
 
 
 
 
 
When you load a Track (any audio file) into Cricket, a Track Number is 
assigned and the Track is added to the Track List.  This is a list of currently 
loaded audio files, all of which are sitting queued in the computer’s RAM 
ready to fire off at any time.  Only the first 400k of the track is loaded into 
RAM, enough of a buffer to give your hard drive a chance to locate the file 
and begin to stream it.  The RAM buffer allows a very quick response time 
from hitting play on a deck or hitting Go! on a Q and hearing sound—much 
faster than if you were purely streaming from the drive.  Make sure you 
have enough RAM for all the Tracks you load—they don’t take up a huge 
amount of space, but 400k per track adds up (~40mb for 100 tracks). 
 
You can load a Track by hitting Load Track or CMD-T.  You will be taken to 
a standard open dialog and asked to select a Track to load.  Choose your 
Track and you will be prompted with a 2nd dialog asking you to confirm the 
Track #.  Cricket will always guess at a Track # one more than the last 
Track # in the current list. 
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If you want to change the Track # Cricket will assign, do so in this dialog, 
and hit OK.  The Track is now loaded and you will be able to enter the 
Track # into a Deck and play it or call the Track # up in a Q. 
 
Bulk Load is a method of loading multiple tracks all contained within a 
single folder.  Hit Bulk Load or CMD-B and you will be taken to an open 
dialog where you can navigate to a folder where the Tracks you want to 
load are located.  Once you have selected the folder, you will be brought to 
a 2nd dialog asking you to confirm the starting Track # for the group of 
Tracks to load. 
 
 
 
 
 
 
 
 
If you wish to change the starting Track number for the bulk load, do so in 
this dialog and hit OK.  The Tracks will load in starting with the first Track # 
and ascending from there. 
 
You can also Load and Bulk Load Tracks by dragging files directly from the 
finder onto the Track List.  This method is the fastest, as Cricket will 
automatically assign the next available Track # without prompting you with 
any dialogs.  You can drop single Tracks, multiple Tracks (by shift-selecting 
in the finder), or folders of Tracks using this method. 
 
Cricket will load in mono or stereo Tracks of these file types:  AIFF, AIFC, 
SD2, WAVE, ULAW, RAW in bit depths up to 64 bit double-precision and at 
sample rates as supported by your audio hardware. 
 
If you have audio files not in these formats such as compressed formats 
like MP3 or AAC, please use another application to convert these to one of 
the above formats (AIFF is generally the most Mac-friendly audio file 
format). 
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Track List 
 
You can open the Track List by clicking on the Track List 
button on the Track Loader.  The Track Loader will 
expand downward to reveal the Track List.  This is a list of 
all your currently loaded Tracks and their associated 
Track #s.   
 
Cricket uses this list and the assigned Track #s to refer to 
these Tracks globally throughout the application.  When 
you play a Track in a Deck, it is the Track # that is the 
reference point internally for Cricket.  Similarly, when you 
create a playback Q in the Q Builder, it is the Track # that 
is stored in the Q data, no other reference point.  If you 
have a Q that plays Track #2, and you decide to change 
the audio file that the Q plays, you can just load in a new 
Track and change the Track # to 2.  This will remove the 
old Track 2 from the list and replace it with your new audio 
file.  No other changes need to be made to the Q as it is 
already set to play Track #2 in the list, regardless of what 
that file may be. 
 
If you want to remove a track from the list permanently, 
click on the track in the list to highlight it and then click 
Remove Track.  You will be prompted with a confirmation 
dialog and upon hitting OK—the Track will be removed. 
 
There is actually more data stored in the Track List than 
meets the eye at first.  If you scroll to the right, you will 
find more details about the audio file.  Track length, 
number of channels, bit depth, sample rate, sample type, 
and full file path/location is also stored here.   

Track        Fileame                                            Length                Ch     Bit    Sample   Sample     File Path/Location 
   #                                                                                                       Depth   Rate        Type 
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The Track List is actually one of four specially-formatted files that Cricket 
saves Show information into.  When you save a show for the first time, the 
Track List file is created with the name ‘yourshowTRACKS’ and placed 
inside a newly created folder called ‘yourshow.crick’.  Each subsequent 
time you save the Show file (File>Save or CMD-S), the Track List file is 
also saved (as well as the Map List and any open Q Lists).  When you open 
the Show file, the associated Track List is opened and loaded into RAM. 
 
Additionally, you can save and load Track Lists individually, separate from 
the saving and loading of a Show file.  The drop-down menu on the Track 
Loader has options to Load Track List, Save Track List, Save Track List 
as…, and Clear Track List.  You can find these options in the Track menu 
as well.  Clear Track List will erase from memory all contents of the Track 
List, and you will be prompted for confirmation before Cricket executes the 
clear. 
 
As you can see, Cricket keeps filename and filepath information in the 
Track List in order to locate your audio files on your hard drive.  If you 
change the name of the file, change the name of a directory or folder in the 
path, or move the track to another location, Cricket will be unable to locate 
the file upon loading the Track List and you will receive an error message 
informing you that “There were problems loading 1 or more tracks.  Please 
check Status Window (cmd-m) for more information.”  The Status Window 
will give further details including which track or tracks were problematic and 
make some attempt at explaining why.   
 
You can export the Track List as a standard text file by choosing the option 
in the Track Menu.  Choose the tab-delimited option if you wish to import 
the file into a spreadsheet software. 

 
 
 
 
 
 
 
 
 
 

Decks 
 
Working with a Deck is similar to working 
with any transport-controlled audio player.  
There are standard buttons for Play, 
Pause, Stop, Rewind & Fast Forward, and 
a toggle to indicate loop status on or off 
(the blue curved arrow button at far left).  
Playing a track is as simple as entering 

the Track # in the upper left corner (either by typing the number and hitting enter 
or by clicking and scrolling—you’ll notice the Track Names will display when you 
change the number) and then hitting play.  If you want to loop the track, make 
sure the loop toggle is latched on and lit in blue.   
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To the right of the transport controls, you’ll find the displayed Deck # and a 
pair of routing choices for the Deck’s stereo output channels.  The drop-
down selectors for the L & R sides each contain all 32 mixer channels.  By 
default, Decks are routed in ascending order in stereo pairs with Deck 1 
patched to Ch 1&2, Deck 2 patched to Ch 3&4, etc.  You can automate the 
Deck to Mixer assignments in a Q with the Deck Assign Q Module. 
 
The pair of faders in a Deck are representative of the Mixer32 channels the 
Deck is assigned to.  In the above example, grabbing and sliding the two 
faders would be equivalent to grabbing and sliding channels 1 & 2 in 
Mixer32.  If you have both the Deck Rack and Mixer32 open at the same 
time, you will see the faders mirror each other’s movements.   
 
 
 
 
 
 
 
 
On the far right of a Deck, you will find information about the track being 
played, including the track # and name, time elapsed in the track, and total 
track length.  Additionally, there is a set of pre-fader meters (as opposed to 
the post-fader meters elsewhere in Cricket).  Below the meters is a small 
playback progress bar.  You can grab and slide this progress bar any time 
during playback or while a track is stopped or paused.  If playback is 
stopped or paused, you can slide the progress bar to any location in the 
track and start or resume playback from that location. 
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Cricket Qs 
 
Q Builder (Tools Menu/Q Menu/CMD-3) 
 
 
 
 
 
 
 
 
 
 
 
 
 
A Q in Cricket is a time-linear series of events stored under the banner of a 
Q # and Q Name.  The Q Builder is where you designate the series of 
events to be triggered when activating a Q.  
 
The Q Builder is attached to a window called the Q-Rack, which is initially 
empty.  In the Q-Rack, you stack Q Modules that activate certain parts of 
Cricket’s audio and midi system.  In the top right corner of the empty Q 
Rack, you will find a small drop-down selector box.  Click and hold this box 
to see a list of available modules.  Currently, there are 10 module types to 
choose from:  Mixer, Deck, Map Assign, Input Assign, Deck Assign, 
Midi Program Change, Midi Note On/Off, Midi CC, SubQList, Autostep.  
While still holding the mouse button down, scroll through the list of modules 
and release the mouse button on your module of choice.  This will be the 
first event in your Q.   
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The drop-down selector in the bottom-right of every module contains the 
same module list you found in the empty Q-Rack.  Selecting a module here 
will insert that module directly below the current module.  
 
In the upper-left of every Q Module is another drop-down selector.  Click 
and hold this selector to choose from the list of module functions available.  
Currently, there is only one available function:  Delete.  Select Delete to 
remove that module from the Q. 
 
When activating a Q, Cricket parses through the Q Modules in the order in 
which you have them stacked, from the top and descending down the Q-
Rack.  Cricket will initiate processes in each module as fast as your CPU 
will handle and then move on.  Depending on the complexity of a Q and the 
amount of modules to parse, a reasonably-sized stack of modules in a Q 
should have the appearance of all having executed at the same moment—
although the actual order will be very specific. The Q-Rack can theoretically 
hold up to 254 modules in one Q, although a stack this large would be 
difficult to navigate and would certainly introduce latency between the 
initiation of the first module and the last module. 
 
You can use the stacking order to intelligently plot out events in your Q as 
you wish them to occur.  For instance, you can stack 2 Mixer Q Modules in 
a Q:  The first will set ch 1&2 to –77 in 0 seconds, the second will fade ch 
1&2 to –10 in 15 seconds.  Upon hitting Go!, ch 1&2 will fade from –77 to –
10 in 15 seconds.  Building the Q in this way, you can be assured that no 
matter what level ch 1&2 are currently at, when you activate this Q, the 
channels will always start the fade from –77 because the first module in the 
stack places ch 1&2 at –77 before the fade activates.  
 
Another example would be a simple playback Q.  Because Cricket has a 
very quick audio trigger finger, it is a good idea to build a playback Q that 
sets all routing and levels first, and then initiates the actual playback as the 
final step.  By stacking your Mixer Q Module at the top, setting the level, 
and stacking the Deck Q Module underneath, activating the playback, you 
can be assured that playback will always initiate AFTER the proper level 
has been set on the mixer.  In playback Qs, you may also want to stack a 
Map Assign Q Module to set mixer output routing and/or a Deck Assign Q 
Module to set deck-to-mixer routing prior to the Deck Q Module, as well. 
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The 2 navigation arrows on the Q Builder will scroll to the last module in the 
rack and the first module in the rack, respectively. 
 
If you wish to empty the Q-Rack and start fresh, hit the Clear button on the 
Q Builder.  This will empty the rack and scroll back to the top position.  
Clearing the rack does not affect any stored Q information. 
 
Storing a Q 
 
You must store your Q in order to capture the current Q-Rack into the Q 
List as a Q.  Store your newly built Q by hitting Store Q in the Q Builder or 
by hitting CMD-J.  However, you must first give your Q a Q# and a Q 
Name. 
 
Qs are labeled with a Q # and Q Name.  The Q Name can be any text or 
numbers you wish, you can use it is a descriptor field or as an alternate 
numbering display (for instance, if you choose to letter your Qs).  The Q# 
serves as both an identifier as well as a numerical index marker in your Q 
List.  Enter any numerical value with up to 2 decimal places as a Q #.  
Cricket will always convert the Q# into a float with 2 decimal places.  You 
can enter a Q# of 1 and upon hitting Store Q, Cricket will convert and store 
this as Q# 1.00.   
 
Cricket always keeps the Q List sorted in ascending numerical order based 
on the Q#s.  If you wish to add a Q before Q 1.00, you would store this new 
Q as Q .50 (or any value < 1.00).  If you wish to add a Q after Q 1.00, you 
would store this new Q as Q 2.00 (or any value > 1.00). 
 
You can reload the Q-Rack with any stored Q by grabbing the Q # in the 
drop-down selector on the Q Builder, or by clicking on the Q in the Q List 
and hitting Load Q-Rack or CMD-R. 
 
If you make any changes to a Q, a red CHANGED banner will appear on 
the Q Builder until you have either re-stored the Q or re-loaded the Q-Rack. 
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Additionally, you can save and load Q Lists individually, separate from the saving and 
loading of a Show file.  The drop-down menu on the Q List has options to Load Q List, 
Save Q List, Save Q List as…, and Clear Q List.  You can find these options in the Q 
menu as well.  Clear Q List will erase from memory all contents of the Q List, and you 
will be prompted for confirmation before Cricket executes the clear. 
 
You can export the Q List as a standard or tab-delimited text file by choosing this option 
in the Q Menu.  The text file will be formatted in a fashion similar to the data structure as 
seen in the Q Editor. 

The Master Q List (Q Menu/CMD-0) 
 
The Master Q List is a linear playlist sorted 
numerically by Q # in ascending order 
displaying the Q# and Q Name of all stored 
Qs available for triggering. Q Lists can be 
used either to view progress as you are 
stepping linearly through the list, or to 
navigate to a specific Q either for editing 
purposes or to trigger from a specific place in 
the Q List.  Only Qs stored in the Master Q 
List are available for triggering directly (see 
more on Sub Q Lists). 
 
The highlight bar in a Q List displays the list’s 
current position.  A Q that is highlighted is 
sitting in the queue ready to fire.  As you 
progress through a show, the list will scroll 
forward with the highlight bar always showing 
the next Q in the list ready to be triggered. 
 
You can also click on a Q and hit To Q Rack 
(or CMD-R) to load the Q-Rack with that Q.  If 
you wish to permanently remove a Q from the 
list, click on the Q and hit Remove Q. 
 
The Master Q List is actually one of four 
specially-formatted files that Cricket saves 
Show information into.  When you save a 
show for the first time, the Master Q List file is 
created with the name ‘yourshowQS’ and 
placed inside a newly created folder called 
‘yourshow.crick’.  Each subsequent time you 
save the Show file (File>Save or CMD-S), the 
Q List file is also saved (as well as the Track 
List, the Map List and any Sub Q Lists).  
When you open the Show file, the associated 
Master Q List is loaded and displayed. 
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1. Modules 

Sub Q Lists (Q Menu) 
 
Sub Q Lists are specialized Q Lists that 
can be loaded or built into a show 
giving the option of alternate linealities 
apart from/concurrent with the Master 
Q List.  Qs in Sub Q Lists are not 
available for triggering directly, but can 
be called upon in the Master Q List with 
the Sub Q List Q Module. 
 
Consider the Sub Q List called ‘Panner’ 
as shown on the right.  It will perform a 
five-part pan between 5 speakers on a 
timeline designated by a series of 
autosteps.  If you call Q 1.00 in Panner 
from a Sub Q List Q in the Master Q 
List, you will start this sequence of 
pans.  You can then still advance 
manually through the Master Q List, 
taking any number of Qs without 
disrupting the timeline set forth in 
Panner. 
 
Click on New Sub Q List to create a 
new Sub Q List for your show.  You will 
be prompted for a name and save-
location for the new Q List. Upon hitting 
OK, this Sub Q List will be available in 
the Sub Q List and Q List drop-down 
selectors throughout Cricket.  You can 
also Load Sub Q Lists (any standard Q 
List file) or Save Sub Q Lists the same 
way you would save a Master Q List. 

Qs to be AUTOSTEPPED are displayed in RED in all Q Lists. 

Cricket saves information about the location and name of all Sub Q Lists created/loaded 
into a Show file and will re-queue those Sub Q Lists upon re-loading the show.  Cricket 
will also save any changes to Sub Q Lists upon saving the Show.  You can permanently 
remove a Sub Q List from the queue by scrolling to Remove Sub Q List in the Sub Q List  
function selector. 
 
The Q Builder has a Q List selector drop-down designating which Q List to store a built Q 
into (Master, by default).  You can store a Q into a Sub Q List by changing the Q List 
name here before storing.  Additionally, clicking on a Q in a Sub Q List will latch the Q 
Builder to that Sub Q List, and hitting To Q Rack or CMD-R will load the Q into the Rack. 
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Q Modules 
 

Mixer Q Module 
 

 
 
 
 
 
 
 
 
 
 
The Mixer Q Module allows you to set levels and timed fades on any two 
Mixer32 or 8Bus Channels. 
 
Use the Ch select drop-box to choose which Channel to affect in the 
module.  If you only want to affect one channel instead of two, select the 
channel to affect in the first drop-box (in the top row, for Ch A), deselect the 
LINK button, and select OFF in the second drop-box (in the bottom row, for 
Ch B). 
 
The LINK button on the module serves two purposes when turned ON (by 
default):  First, it serves to link Ch A to Ch B in the module itself, so that for 
stereo purposes, you only need to enter levels and times for Ch A, and Ch 
B will automatically set to the same values.  Second, when the Q is called, 
it will send the Link setting to that pair of channels, so that you can link or 
unlink channels on cue. 
 
Enter a time (in seconds) for a timed fade in the TIME field.  Enter a time of 
0 seconds to set an immediate level.  
 
Enter a time (in seconds) for the module to wait before activating (once it is 
called in a Q) in the DELAY field.  Enter a time of 0 seconds to have the 
module activate immediately upon being called. 
 
Use the Fader or Level Display box to set a level for the channel assigned 
in the Ch select drop-box.  The channel(s) will fade to the level assigned on 
a time as set by the TIME field, with the start offset by the DELAY time. 
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0.=Linear .5=Exponential -.5=Logarithmic 

Select Fade Type 1, 2, or 3 for the fade.  The Fade Types are set globally 
in the Preferences window under the General tab.   You can choose a 
value from –.99 (logarithmic) to +.99 (exponential) for each fade with a 
value of 0 being a ‘straight’ curve.   
 
 
 
 
 
 
 
 
 
 
 
The curve editor in the Preferences window will show a visual 
representation of what the curve ‘looks’ like for a fade up or down, and you 
can grab the small handle to pull the curve either direction. 
 
Another View of Curve Types 
Consider a 10-second trajectory that passes through points A-G.  In all three curve types, point 
A will be at 0 seconds and point G will be at 10 seconds, but the time at which points B-F are 
reached depend on the curve of the trajectory.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Clicking on the small target in the title bar of the Mixer Q Module (right next 
to the text ‘Mixer Q’) will turn on live updating of the assigned channels 
from Mixer32 or 8Bus to the module. 
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Deck Q Module 
 
 
 
 
 
 
 
The Deck Q Module gives you basic control over track playback in a Deck.   
 
Choose a Deck to control in the Deck selection drop-down box.   
 
Choose an action (play, loop, stop) in the action drop-down box.   
 
Select a Track to play or loop from the number box which is populated with 
Tracks loaded in your Track List.  You do not need to select a track to stop 
if you want to stop playback on a Deck.  Choosing the Deck # and the Stop 
action is sufficient. 
 
Enter a time (in seconds) for the module to wait before activating in the 
Delay field. 
 
Clicking on the small target in the title bar of the Deck Q Module (right next 
to the text ‘Deck Q’) will turn on live updating of the chosen Track from the 
assigned Deck to the module. 
 

Map Assign Q 
 
 
 
 
 
 
 
The Map Assign Q Module allows you to assign any two Mixer32 or 8Bus 
Channels to any Matrix Maps you have built in the Matrix Mapper.   
 
Choose a Mixer32 or 8Bus channel to assign in the Ch select drop-down 
box.  
 
Choose a Matrix Map assignment from the Map List drop-down box.  
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You can also assign any Mixer32 Channel to any 8Bus Channel in this 
module. 
 
Enter a time (in seconds) to create a timed pan from one Map to another in 
the Time field. Enter a time of 0 seconds to set an immediate map 
assignment. 
 
Enter a time (in seconds) for the module to wait before activating (once it is 
called in a Q) in the DELAY field.  Enter a time of 0 seconds to have the 
module activate immediately upon being called. 
 
Clicking on the small target in the title bar of the Map Assign Q Module 
(right next to the text ‘Map Assign Q’) will turn on live updating of the 
chosen Map from the assigned Mixer Channel to the module. 
 

Input Assign Q Module 
 
 
 
 
 
 
 
The Input Assign Q Module allows you to assign any Input built in your 
system to any Mixer32 Channel. 
 
Choose an Input # from the drop-down selector.  Only Inputs you have built 
in the system will be available here. 
 
Select a Mixer32 Channel from the Mixer Ch drop-down selector.  This is 
the Channel you want to route your selected Input to. 
 

Deck Assign Q Module 
 
 
 
 
 
 
 
The Deck Assign Q Module allows you to assign any stereo Deck built in 
your system to any pair of Mixer32 Channels. 



 36 

 
Choose a Deck # from the drop-down selector.  Only Decks you have built 
in the system will be available here. 
 
Select Mixer32 Channels from the Mixer Ch drop-down selectors for each 
side of the stereo Deck’s outputs. 
 
Note:  By Default, Decks are pre-assigned to channel pairs in ascending 
order.  (i.e., Deck 1>Ch1&2, Deck 2>Ch3&4, Deck 3>Ch5&6, etc.)  If you 
have more than 16 Decks, the default channel assignments will wrap 
around to the first pair of mixer channels and continue from there. 
 

Midi Program Change Q Module 
 
 
 
 
 
 
 
The Midi Program Change Q Module allows you to send Midi Program 
Changes from Cricket to midi equipped hardware or another midi 
application. 
 
Enter a Program # to send in the Program # box (0-127).  Note:  some 
hardware does not use the program # ‘0’, and thus may interpret program 
numbers off by 1. 
 
Enter a time (in seconds) for the module to wait before sending the 
program change in the Delay field. 
 
Enter a Midi Out Port in the Out drop-down selector.  Only the hardware 
midi interfaces you have currently attached and configured will appear 
here.  Additionally, there are 2 virtual ports labeled ‘from Cricket 2.0 1’ and 
‘from Cricket 2.0 2’ that you can use to send to any application.  Any midi-
enabled application running will also have 2 virtual ports available  
 
Enter a Midi Channel (1-16) to send on in the Ch number box. 
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Midi Note Q Module 
 
 
 
 
 
 
The Midi Note Q Module allows you to send midi notes from Cricket to midi 
equipped hardware or another midi application. 
 
Enter a note value to send in the Note selector box. 
 
Enter a note velocity (0-127) to send in the Vel number box.  A velocity of 0 
will act as a Note Off. 
 
Enter a time (in seconds) for the module to wait before sending the note in 
the Delay field. 
 
Enter a Midi Out Port in the Out drop-down selector.  Only the hardware 
midi interfaces you have currently attached and configured will appear 
here.  Additionally, there are 2 virtual ports labeled ‘from Cricket 2.0 1’ and 
‘from Cricket 2.0 2’ that you can use to send to any application.  Any midi-
enabled application running will also have 2 virtual ports available  
 
Enter a Midi Channel (1-16) to send on in the Ch number box. 
 

Midi CC Q Module 
 

 
 
 
 
 
 
The Midi CC Q Module allows you to send midi cc values and timed midi cc 
fades from Cricket to midi equipped hardware or another midi application. 
 
Enter a CC number (0-127) to affect in the cc# box. 
 
Enter a starting CC value (0-127) and an ending CC value (0-127) in the 
Start and End number boxes.  If you are sending only a single value, enter 
the same value in Start and End. 
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Enter a time (in seconds) for the CC fade to move from its Start value to its 
End value in the Time field. 
 
Enter a time (in seconds) for the module to wait before sending the CC 
value(s) in the Delay field. 
 
Enter a Midi Out Port in the Out drop-down selector.  Only the hardware 
midi interfaces you have currently attached and configured will appear 
here.  Additionally, there are 2 virtual ports labeled ‘from Cricket 2.0 1’ and 
‘from Cricket 2.0 2’ that you can use to send to any application.  Any midi-
enabled application running will also have 2 virtual ports available  
 
Enter a Midi Channel (1-16) to send on in the Ch number box. 
 

Sub Q List Q Module 
 

 
 
 
 
 
 
The Sub Q List Q Module will call up a Q from any previously built/loaded 
Sub Q Lists. 
 
Select a Sub Q List from the menu.  All Sub Q Lists you have loaded into 
the show will be available here.  If this menu is empty, open the Sub Q List 
window and load or create a new Sub Q List. 
 
Select a Q # to call from the Sub Q List selected.  If this menu is empty, 
you may need to build and store Qs in the Sub Q List or select a different 
Sub Q List from the menu. 
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Autostep Q Module 
 
 
 
 
 
 
The Autostep Q Module will create a timed automatic trigger (autofollow) 
for the next Q in the Q List. 
 
Enter a time (in seconds) to autostep to the next Q. 
 
All Qs to be autostepped (the next Q in sequence after the one containing 
the Autostep Q Module) will display in the Q List in red.  
 
Note:  All timed events triggered in a Q (including those offset by delays) 
will continue as programmed, even if the next Q is taken before timed 
events have completed, or in some cases (with delays), before they have 
even initiated. 
 
Q Templates 
 
 
 
 
 
You can save any built Q into a Template for easy recall of common Q 
types.  Hit Save Template in the Q Builder and you will be asked for a 
Template Name.   
 
Templates are saved into your User directory at Library/Application 
Support/Cricket/Q Templates/.  When the app is started, any templates 
found in this folder will load into the template drop-down selector found in 
the Q Builder next to the Save Template button. 
 
To load a template, simply select it from the template select drop-down as 
you would select a module in the Q Rack. 
 
The Cricket 2 installer comes with a set of templates to get you started.  
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Q Editor (Q Menu) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Q Editor is an optional text-entry editor for Qs already built in the Q 
Builder.  Use the Q Editor as a quick alternative to graphically editing Qs in 
the Q Builder.  It is especially useful on complex Qs that may be time-
consuming to reload or navigate through in the Q Builder.  
 
NOTE:  Use caution editing with the Q Editor.  It is entirely possible to enter 
mistyped data into a field or otherwise corrupt the formatting of a Q by 
entering the wrong data into the wrong field.  The module data is displayed 
in Cricket’s internal Q data parsing format, and Cricket needs the data to 
maintain this precise format in order to execute a Q properly.  Despite this, 
with caution, you can effectively use the Q Editor as an advanced tool for 
quickly editing Q data directly. 
 
You cannot build new Qs or add/delete modules in Q Editor—you must use 
the Q Builder for that purpose.  Use Q Editor not to alter the structure of a 
Q, but rather to make changes to the structure as built. 
 
Rather than graphically building the Q as in the Q Builder/Q Rack, the Q 
Editor will instantly populate with Q data upon clicking on a Q in the Q List.  
Alternately, you can call up a Q by grabbing it in the Q# drop-down box in 
the Q Editor. 
 
In Q Editor, Qs are laid out in a spreadsheet-like format with each row 
dedicated to an entire Module and columns dedicated to the data in the 
each Q.   
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Each module has its own data format due to the modules’ differing data 
structures, so they will all appear slightly different in Q Editor. 
The first 3 columns in any module are uneditable and display information 
about the stacking order of the modules (col 1), the module type (col 2), 
and Q Rack starting window height in pixels (col 3).  The following columns 
contain the varying data for each module. 
 
 
 
 
 
These 2 rows in Q Editor correspond to these 2 modules in Q Builder.  
Note:  in this example, only a portion of the mixerq data is displayed above.  
The modules below would be the 3rd and 4th modules in the rack. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Q Data is generally formatted as Field Type>Field Data.  So, for instance in 
the Deck Q Module as displayed in the Q Editor above: deck>10, 
action>loop, track>171, del>0.00.  If you wanted to change the Track 
played to #24, you would replace the 171 in the deckq row with 24, hit 
enter, and then Store Q. 
 
To navigate through the Q Editor, you can tab (left) or shift-tab (right) or 
arrow (up/down) from field to field. 
 
No changes are made to a Q until you have hit Store Q or CMD-J. 
 



 42 

You can renumber a Q in Q Editor by typing a new number in the 
Renumber Q field and hitting Enter.   
 
You can rename a Q by typing a new name in the Q Name field and hitting 
Store Q. 
 
If you have the Q Builder window open at the same time as the Q Editor: 
 

1) Hit ‘Load Q-Rack’ in Q Editor to load the current Q into the Rack for 
graphic editing. 

2) Loading the Q Rack from the Q Builder will cause the Q Editor to 
update to reflect the newly loaded Q. 

3) Storing a Q in the Q Builder will cause the Q Editor to update to 
reflect the newly stored Q data. 

4) Storing a Q in the Q Editor will cause the Q Rack to reload the newly 
stored Q from Q Editor. 

5) Hitting CMD-J will store a Q as currently built in the Q Builder.  If the 
Q Builder window is closed, and the Q Editor window is open, hitting 
CMD-J will store a Q as currently built in the Q Editor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 43 

Cricket Show Operation 
 
In order to activate a Q in Cricket, you must have Live Mode turned 
on.  You can turn on Live Mode by hitting the DELETE key or by clicking  
the Live button on the Show Panel or on the Q Player.  
 
Q Player (Tools Menu/CMD-4) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Q Player is a show operation panel and navigation tool for the Master 
Q List.  It is comprised of a large GO! button, a Stop Sequence button, a 
Live Mode toggle, Master Q List navigation arrows, a Goto Q button and 
entry box, and displays for the current and next Qs. 
 
The GO! button will always display in red the next Q ready to fire in the 
Master Q List and so is therefore linked to the highlight bar in the Master Q 
List.  The Q displayed in white to the left of the button is the last Q 
activated.  Hitting Go! in the above example would activate Q #1.20.  The 
Display on the Left would then change to display Q# 1.20 and the Go! 
button would update to display the next Q in the list.  If the next Q in the list 
is programmed to trigger from an autostep, the Go! button will display 
AUTO in red above the word GO!. 
 
Hitting spacebar or the enter/return keys will also trigger Go! by default, 
however you can turn off either Go! key commands if you wish in the 
Preferences Window under the General Tab. 
 



 44 

You can also turn on Double-Go Protection in the Preferences Window 
under the General Tab.  This allows you to set a time (in seconds) after you 
Go on a Q in which Cricket will not respond to manual Go commands.  Use 
this to reduce the chances of any accidental double-clicking of the Go 
button or Go key commands.  Autostepping is not affected by Double-Go 
Protection. 
 
Hit Stop Sequence (escape key) to stop all audio, fades, delays, and 
autofollows.  A Stop Sequence button is also found on the Show Panel. 
 
The navigation arrows will step backwards or forward through the Master Q 
List.  You can also use the L&R/up&down keyboard arrows to navigate. 
Enter a Q# in the Goto Q field and hit enter or click on Goto Q to navigate 
directly to that Q.  It will then be sitting in the queue ready to fire. 
 
Q Clok (Q Menu) 
 
 
 
 
 
 
 
 
 
The Q Clok is a small timer panel which automatically displays timings 
between instances of Go.  The top 2 rows of times will alternate counting 
each time you hit Go! and will stop if you hit Stop Sequence. Use this to 
find out timings between Qs for autostepping or any other time-critical 
purpose.  The bottom counter in red is a manual timer that can be started 
and stopped with the Start and Stop buttons.  Each time you hit Start, the 
counter is automatically reset. 
 
Show Mode (Options Menu/CMD-‘) 
 
If you save a show with Show Mode on, upon loading the show, Live Mode 
will already be latched on (saving your operator one extra step) and the Q 
Builder/Q Editor windows will be locked out.  Use this when you are running 
a show and no longer need to make daily changes.  You can always turn 
off Show Mode and make further changes to the show at any point. 
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Control Builder (Tools Menu) 
 
 
 
 
 
 
 
 
 
 
 
 
Use the Control Builder to allow external midi control over common 
tools/functions in Cricket.  
 
Control Builder currently gives you midi control of: 
 

1) GO! 
2) STOP SEQUENCE 
3) MASTER FADER 
4) MASTER MUTE 
5) MIXER CH 1-32 
6) BUS CH 1-8 

 
Choose a Cricket tool or function in the Control column.  The Type selector 
box will update to reflect the types of Midi controls available for that tool or 
function.  All Faders (Master, Mixer, Bus) can be controlled by Midi CC 
only.  All other tools/functions can be controlled by Midi Program Change, 
Midi Note, or Midi CC. 
 
Choose a midi control type in the Type column.  The Parameter field will 
update to reflect the options available for that control type. 
 
Midi Note gives you the option to select a Note, the Midi Input Port, and a 
Midi Channel.  When Cricket is sent the selected note through the selected 
midi port and channel, the appropriate function will be triggered. 
 
Midi Program Change gives you the option to select a Program #, the Midi 
Input Port, and a Midi Channel.  When Cricket is sent the selected program 
# through the selected midi port and channel, the appropriate function will 
be triggered. 
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Midi CC gives you the option to select a CC #, the Midi Input Port, and a 
Midi Channel.  When Cricket is sent values for the selected CC # through 
the selected midi port and channel, the selected tool or function will be sent 
those values.  Cricket expects to see cc values from 0-127 at its inputs.  It 
translates those values differently for each tool/function: 
 

•  For all faders, Cricket smoothly scales 0-127 into the full   range of 
a fader with 0=-77 and 127=+17.2. 
•  For all triggers (Go!, Stop Seq), Cricket accepts any value 0-127 as 
triggers for the function. 
•  For all toggles (Master Mute), Cricket translates any non-zero value 
as ON and zero as OFF. 

 
Additionally, Cricket can have cc values return to the midi device using the 
Param Return target button.  If this is turned on, any state changes made to 
the selected tool/function inside the software will return scaled back down 
to 0-127 to the midi device using the same named midi port and channel as 
the input.  Use this with compatible midi hardware to have motorized faders 
and/or rotary knobs latch onto the state of their software counterparts. 
 
All controls built in the Control Builder are saved into a Show File in a 
similar fashion to Master EQ settings.  Also similarly to the EQ, you can 
save and load a Control List as a separate file, if you have, for instance, 
built a complex midi hardware Control List that you wish to use outside the 
context of a particular show. 
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Cricket Files 
 
Show Files 
 
When you save a show for the first time, 4 Files are created on your hard 
drive.  Hit Save or Save As…in the File Menu and you will be prompted to 
enter a Show name and save location.  Upon hitting OK, Cricket will create 
a Show File called <yourshow> and a folder called <yourshow>.crick.  The 
folder will contain 3 other show files called <yourshow>QS, 
<yourshow>MAPS, and <yourshow>TRACKS.  These are the four main 
show filetypes in Cricket. 
 
The Show file is the main file created and is the file you use to open the 
show either by double-clicking the file in the finder or by clicking Open in 
the File Menu.  The Show file contains links to all Q Lists, Track Lists, and 
Map Lists and holds all Master settings, Control Builder settings, General 
Preferences, System Settings, and window positions for the show. 
 
 
 
 
 
 
 
 
 
 
Show Panel (Tools Menu) 
 
 
 
 
The Show Panel is a simple toolbar to display information about the loaded 
show, plus gives quick access to a few common functions in Cricket.  On 
the Show Panel you will find a Live Mode Toggle/Display, an All-Pause 
button which pauses all Decks, and a Stop Sequence button.  Additionally, 
you will find fields that display the name of the current-loaded show, the 
total number of Qs built in the Master Q List, the total number of tracks 
loaded in the Track List, and the number of Inputs, Outputs, and Decks 
built in your current system.  If you click on any of the fields for Ins, Outs, or 
Decks, you will open up the Preferences Window with the System tab 
displayed. 

      Show File                                                  Q List                                              Track List                                          Map List 



 48 

Clicking on New in the File Menu will create a new blank show based on 
your Default Show. 
 
Default Show 
 
The Default Show is a set of Show Files kept in your Cricket 2 Preferences 
Folder.  Cricket loads this Default Show each time you start the application, 
so you can have a pre-built blank show template that works for your 
system.  In order to customize your Default Show, set up the show to your 
liking, including any system settings, master settings, window positions, or 
anything else you’d like to have recalled each time the app is started or a 
new show is created, and click on Save As Default in the File Menu.  You 
will be given a confirmation dialog, and upon hitting OK, your new Default 
Show will be saved.  The next time you start Cricket, your new Default 
Show will be loaded at startup. 
 
Once you save a show, it is important not to move or rename any 
associated files or Cricket will not be able to locate the files.  This includes 
any of the 4 main Show files, any Sub Q Lists, and any Tracks loaded in 
the Show.  If you need to transfer a Show to a new location, such as from 
the laptop to the theater, you need to use the Transport Show function. 
 
Transport Show 
 
In order to use Transport Show, you must first do a little work in the OSX 
Finder.  You will need to copy all the files associated with the Show to your 
new location.  This includes all 4 main Show Files, any Sub Q Lists, and all 
Tracks from the Track List.  In order to properly Transport the Show, all 
Tracks to be transported will need to be in one main folder with no nested 
subfolders.  For this reason, it is a good idea to always keep your loaded 
tracks in one tracks folder. 
 
Once you have copied over all the show files to the new location, you can 
start Cricket and select Transport Show from the File Menu. 
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You will then be offered a series of dialogs asking you to point to all the 
newly copied show files. (It is important that you point to the new copies of 
the files in their new locations, not the old versions).  Finally, Cricket will 
ask you to point to the Tracks folder where all of the newly copied Tracks 
reside.  After it has processed and updated the new filepaths for all the 
show files, Cricket will inform you that the Show has been transported and 
will ask you if you want to save the path changes.  Click OK and you will 
then be ready to open the Show in its new location.  If you receive error 
messages when you try to open the new show—check your new Tracks 
folder and make sure all the Tracks listed in the Track List are sitting in that 
folder and then try transporting the show again. 
 
If you have good file management skills and keep all your files in their 
original save-locations and keep all your tracks in one tracks folder, 
transporting the show from location to location should be a very simple 
procedure. 
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Appendix I. 
 
Q Module Data Format 
 
The following is the data format for each Q module in Cricket as seen in the Q Editor and text-exported Q 
Lists.  Cricket expects module data to retain this format.  When editing in Q Editor, be sure to only edit the 
fields as shown in red below, all other fields should be left as-is. 
 
Mixer Q Module 
mixerq 15 A ch 1 lev 0.0000 tim 0.0000 del 0.0000 typ 1 B ch 2 lev 0.0000 tim 0.0000 del 0.0000 typ 1 link 1 live 0 
 
1) symbol ‘mixerq’ identifying the module 2) q-rack pixel height 3) symbol ‘A’ identifying channel 
4) symbol ‘ch’ 5) channel number 0-40 (0=off,1-32=mixer32 channels,33-40 8bus channels) 6) 
symbol ‘lev’ 7) level in db 8) symbol ‘tim’ 9) time in seconds 10) symbol ‘del’ 11) delay time in 
seconds 12) symbol ‘typ’ 13) fade type (1,2,3) 14) symbol ‘B’ identifying channel 15) symbol ‘ch’ 
16) channel number 0-40 (0=off,1-32=mixer32 channels,33-40 8bus channels) 17) symbol ‘lev’ 
18) level in db 19) symbol ‘tim’ 20) time in seconds 21) symbol ‘del’ 22) delay time in seconds 
23) symbol ‘typ’ 24) fade type (1,2,3) 25) symbol ‘link’ 26) link off/on status (0/1) 27) symbol 
‘live’ 28) live target off/on status (0/1) 
 

Deck Q Module 
deckq 175 deck 1 action play track 1 del 0.0000 live 0 
 
1) symbol ‘deckq’ identifying the module 2) q-rack pixel height 3) symbol ‘deck’ 4) deck # 5) 
symbol ‘action’ 6) deck action (play/loop/stop) 7) symbol ‘track’ 8) track # 9) symbol ‘del’ 10) 
delay time in seconds 11) symbol ‘live’ 12) live target off/on status (0/1) 
 

Map Assign Q Module 
mapassignq 247 ch 1 map out 1 time 0.0000 del 0.0000 MPQ# ch 2 map out 2 time 0.0000 del 0.0000 MPQ# live 0 
 
1) symbol ‘mapassignq’ identifying the module 2) q-rack pixel height 3) symbol ‘ch’ 4) channel 
number 0-40 (0=off,1-32=mixer32 channels,33-40 8bus channels) 5) symbol ‘map’ 6) map 
name from map list 7) symbol ‘time’ 8) time in seconds 9) symbol ‘del’ 10) delay time in seconds 
11) symbol ‘MPQ#’ identifying end of Ch A data 12) symbol ‘ch’ 13) channel number 0-40 
(0=off,1-32=mixer32 channels,33-40 8bus channels) 14) symbol ‘map’ 15) map name from map 
list 16) symbol ‘time’ 17) time in seconds 18) symbol ‘del’ 19) delay time in seconds 20) symbol 
‘MPQ#’ identifying end of Ch B data 21) symbol ‘live’ 22) live target off/on status (0/1) 
 

Input Assign Q Module 
inputassignq 327 input 1 ch 0 live 0 
 
1) symbol ‘inputassignq’ identifying the module 2) q-rack pixel height 3) symbol ‘input’ 4) input # 
5) symbol ‘ch’ 6) channel number 0-32 (0=off,1-32=mixer32 channels) 7) symbol ‘live’ 8) live 
target off/on status (0/1) 
 

Deck Assign Q Module 
deckassignq 399 deck 1 Lch 0 Rch 0 live 0 
 
1) symbol ‘deckassignq’ identifying the module 2) q-rack pixel height 3) symbol ‘deck’ 4) deck # 
5) symbol ‘Lch’ 6) channel number 0-32 (0=off,1-32=mixer32 channels) 7) symbol ‘Rch’ 8) 
channel number 0-32 (0=off,1-32=mixer32 channels) 9) symbol ‘live’ 10) live target off/on status 
(0/1) 
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Midi Program Change Q Module 
midipgmchangeq 471 pgm 0 del 0.0000 ch 1 out from Cricket 2.0 1 
 
1) symbol ‘midipgmchangeq’ identifying the module 2) q-rack pixel height 3) symbol ‘pgm’ 4) 
program # 5) symbol ‘del’ 6) delay time in seconds 7) symbol ‘ch’ 8) midi channel 9) symbol ‘out’ 
10) name of midi out port 
 
 

Midi Note Q Module 
midinoteq 543 note 0 vel 0 del 0.0000 ch 1 out from Cricket 2.0 1 
 
1) symbol ‘midinoteq’ identifying the module 2) q-rack pixel height 3) symbol ‘note’ 4) midi note 
# (0-127) 5) symbol ‘vel’ 6) note velocity (0-127) 7) symbol ‘del’ 8) delay time in seconds 9) 
symbol ‘ch’ 10) midi channel 11) symbol ‘out’ 12) name of midi out port 
 

Midi CC Q Module 
midiccq 615 cc 0 start 0 end 0 time 0.0000 del 0.0000 ch 1 out from Cricket 2.0 1 
 
1) symbol ‘midiccq’ identifying the module 2) q-rack pixel height 3) symbol ‘cc’ 4) midi cc # (0-
127) 5) symbol ‘start’ 6) cc start value (0-127) 7) symbol ‘end’ 8) cc end value (0-127) 9) symbol 
‘time’ 10) cc fade time in seconds 11) symbol ‘del’ 12) delay time in seconds 13) symbol ‘ch’ 14) 
midi channel 15) symbol ‘out’ 16) name of midi out port 
 
Sub Q List Q Module 
subqlistq 687 subqlist newsubqlist Q# 2.00 
 
1) symbol ‘subqlistq’ identifying the module 2) q-rack pixel height 3) symbol ‘subqlist’ 4) name of 
Sub Q List 5) symbol ‘Q#’ 6) Q # from Sub Q List 
 

Autostep Q Module 
autostepq 759 time 0.0000 
 
1) symbol ‘autostepq’ identifying the module 2) q-rack pixel height 3) symbol ‘time’ 4) autostep 
time in seconds 
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Appendix II. 
 
Key Commands 
 
cmd-1   Deck Rack 
cmd-2   Track Loader 
cmd-3   Q Builder 
cmd-4   Q Player 
cmd-5   Mixer32 
cmd-6   Input Master 
cmd-7   Output Master 
cmd-8   Mix Master 
cmd-9   Control Builder 
cmd-0   Master Q List 
cmd-J   Store Q 
cmd-R  Load Q Rack 
cmd-T  Load Track 
cmd-B  Bulk Load Tracks 
cmd-< ' >   Show Mode 
cmd-F   Fast Fade 
cmd-M  Status Window 
opt-Z  Kill autosteps/delays 
opt-<0-9>  Play Deck 1-10 (option-0=play deck 10) 
shift-<0-9>  Stop Deck 1-10 (option-0=stop deck 10) 
ctrl-F  Clear Faders (all mixer channels to -77) 
<ESC>   Stop Sequence 
<P>   All Decks Pause 
<DEL>   Toggle Live Mode 
<SPACE> / <ENTER>  optional GO keys 
L/UP Arrow   Scroll back in Master Q List 
R/Down Arrow   Scroll forward in Master Q List 
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Appendix III. 
 
Tips/Troubleshooting 

 
• Tracks should all have a unique name, even if they are located in 

different locations. 
 

• If you are having trouble loading certain tracks, check the filename 
and/or pathname for any questionable symbols (backlashes and colons, 
for instance, are used in OSX pathnames).  Try simplifying the Track 
name and then try reloading.  Check the Status Window for error 
messages. 
 

•  The Options Menu has the option to Reset Windows in case you have 
lost track of certain windows or have resized windows or repositioned 
windows in such a way that they are not showing up on the monitor.  
Windows will be reset to their default positions.  This is particularly 
useful if you transfer shows between systems with different size/amount 
of monitors. 

 
• The Status Window (CMD-M) can be found in the Window Menu.  It is a 

general log-type window where many useful things are reported.  Some 
of which include:  Any error messages due to difficulty of loading tracks, 
all Q Data for each Q taken, a time stamp for every save of the show 
file, and others.  If you ever encounter problems, the Status Window is a 
good place to check for hints. 

 
• Functions in the standard Apple Edit Menu are of very limited use in 

Cricket.  Undo/Redo do nothing at all.  Cut, Copy, Paste, and Clear only 
have use in Text Fields. 

 
• CMD-Q will quit the application per the Apple standard, and will check 

your current Show for any changes since it was last saved (if at all).  If 
any changes are found, you will be reminded of such and prompted to 
save the Show.  There is a Quit in the File Menu (ala OS9) as well that 
operates in exactly the same way.  The Quit in the Application Menu (ala 
current OSX standard) will NOT check for changes and will quit the 
application immediately. 

 
• If you are ever in doubt about the version of Cricket 2 you are using, 

check About Cricket… in the Application Menu.  There will be an 
extended version number and build date posted there. 
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Appendix V. 
 
What’s New in Cricket 2.2? 
 
 
Input/Output Patching 

 
With the new Input and Output Patches, you can now custom-patch 
Cricket’s virtual outputs to your audio hardware’s actual outputs.  In 
previous versions, Cricket Output 1 was hard-wired to your interface’s 
Output 1, Out 2>Out 2, etc. Now you can patch any of your built Cricket 
outputs to any of your interface’s available outputs (the same is true for 
inputs).  This also means that Systems are no longer limited in size based 
on your physical hardware.  The maximum number of Inputs and Outputs 
are each limited to 128, decks limited to 64 (you shouldn’t try that out—your 
computer will groan at you!).  Say, for instance you are using a MOTU 828 
and only need to make use of analog outputs 1 and 2 and also the digital 
S/PIDF, which appears as outputs 23&24.  In previous versions, you would 
have to build a system with 24 outputs to have access to the S/PIDF 
outputs, but with the new Input and Output Patches, you can build a system 
with only 4 outputs, and then patch your MOTU into the outputs 
appropriately.  You can find the Input and Output Patches on the System 
Setup tab of the Preferences Panel. 
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Live Matrix Mapping 

 
The Cricket Matrix Mapper has gotten an upgrade.  At the bottom of the 
Mapper panel is a new row of controls allowing you to preview a Map 
before you store it.  The Live Matrix button toggles the mode on or off.  
With Live Matrix on, you can choose a Preview Mixer Channel to route to 
the live matrix.  Once selected, you can slide the Matrix Mapper virtual 
faders around and hear your selected mixer channel mixed into the output 
matrix in real time.  You can then store the map and turn off Live Matrix 
mode if you wish. 
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Matrix Mirror 

 
The Matrix Mirror is a new sub-patch for creating Matrix Maps and Live 
Matrices based around stereo pairs of outputs.  In the Matrix Mirror panel is 
a set of user-defined stereo pairs based on your current system.  Here you 
can set which outputs supporting the left side of a stereo signal should be 
grouped with which outputs supporting the right side of the stereo signal.  
Cricket defaults to odd-even concurrent pairs starting with 1-2, 3-4, etc.  
The Matrix Mirror is a universal, set-once-and-forget panel and the mirror is 
saved into a show file.  With a properly designed mirror (for many cases, 
the default 1-2, 3-4 pairings will work just fine), you can save time building 
Live Matrix Maps, and Live Matrix Qs.  You can find the Matrix Mirror panel 
in the new Map menu. 
 
In the Matrix Mapper panel is a checkbox to turn on/off the Matrix Mirror 
function.  If Mirror is on, and Live Matrix is on, any changes you make to 
the Live Matrix settings in the panel will be reflected through the Matrix 
Mirror into their stereo right-side counterparts.  The stereo-linked Preview 
Mixer Channel should be set here as well.  The drop-down selector will 
default to +1 the channel number of the main Preview Channel, but you 
can choose a different stereo link.  Once you have mapped out a nice 
stereo-supported matrix, if you store the map, Cricket will automatically 
store both the left side map and the right side.  For instance, if you store a 
map called Full House with mirror on, Cricket will create 2 maps:  Full 
House.L and Full House.R. 
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Cricket Link 

 
Cricket Link is a native way to remotely control a Cricket machine from a 
duplicate Cricket setup via a shared Local Area Network (this can be wired 
ethernet or Wi-Fi).  In the Preferences panel is a new tab called Cricket 
Link.  Here you can turn Cricket Link OUT or IN on or off.  Turn on Cricket 
Link OUT on the controlling machine.  Turn on Cricket Link IN on the 
receiving machine.  You can filter what commands are sent through the 
Cricket Link system on the controlling machine.  You can send the Go, 
Stop Sequence, and System Pause commands and you can toggle Live 
Mode on/off.  Additionally, you can sync up the Master Q Lists so that any 
Q List navigation follows from controlling machine to receiving machines.  
Finally, you can store Qs as well as create new Qs from scratch through 
Cricket Link.  Any of these functions can be filtered through the Cricket Link 
OUT on the controlling machine.   
 
Creating the Cricket Link is quite easy.  First, make sure both machines 
have access to the same Local Area Network either through a physical 
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ethernet connection, or through a WiFi network adapter.  You need to know 
the IP address of the receiving machine and enter it into the Destination IP 
field.  If you look at the receiving machine’s Cricket Link panel, you can find 
the machine’s IP address in the Local IP Address display.  You also need 
to enter an available OUT port on the controlling machine.  You will enter 
this same port number into the IN port on the receiving machine.  Make 
sure Cricket Link IN is turned on in the receiving machine’s link panel and 
your link should be constructed. 
 
Cricket Link works best when you work with identical copies of a show on 2 
different machines (say, the designer’s laptop in the house and the Mac 
Mini in the booth hooked up to the sound system).  With these 2 machines 
linked, the designer can run through Qs, and make many adjustments 
remotely from the house on the laptop.   
 
The Link is created using the Open Sound Control protocol to send packets 
of data through the network between Cricket instances.  No audio is sent, 
just a low-latency set of commands from the controlling machine to the 
receiving machine.   
 
Cricket Link can also be used to sync up a redundant system.  Because the 
Link is nothing more than data commands, if you were to lose the 
controlling machine to mechanical or system failure, it would only affect the 
receiving machine insomuch as it would no longer receive the remote 
commands and would need to be manually controlled. 
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Midi Show Control Module 

 
Cricket has a new Midi Show Control Module used for sending MSC 
commands to other devices/software that can receive incoming MSC.  The 
module follows the MSC 1.0 specifications, allowing you to enter the 
necessary commands/data in a user-friendly format.  Cricket then converts 
the module data into the proper MSC sysex format.  Please refer to your 
MSC-capable hardware/software’s documentation to find out how to 
program for each device.  You can set a module delay time similar to other 
modules that will wait a specified amount of time before sending the MSC 
command after hitting Go.  
 
Live Matrix Module 

 
The Live Matrix Module is a new way of programming matrix sends in a Q.  
Instead of applying Matrix Maps ala the Map Assign Q module, in the Live 
Matrix Module, you make adjustments directly to a set of virtual output 
faders similar to the Matrix Mapper window.  This allows you the ability to 
make small adjustments to output matrix sends without the need for making 
individual matrix maps for each adjustment.   
 
Choose a single Mixer Channel in which to apply the Live Matrix in the 
drop-down menu on the left.  On the right, you can choose a Time (in 
seconds) in which the Live Matrix adjustment will be made (pan time). Also 
on the right is a field to enter a Delay time (in seconds) similar to other 
modules in Cricket. 
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In the center of the module is a button depicting virtual output faders.  Click 
this to open up the Live Matrix Q Mapper.  This is a set of virtual faders 
much like the Matrix Mapper window in which you can make the desired 
adjustments you wish to apply in the Q.  There is a Map List drop-down 
here to let you pull up any built maps as a starting place.  If you control-
click on the name of any virtual faders (Output 1, Output 2, etc.) you can 
disable any particular virtual fader in the module.  This way you can make 
adjustments only to the part of the output matrix send that needs it.  For 
instance, if you wish to pull an individual speaker out of a matrix send, you 
can do this by control-clicking all the faders except the one you wish to 
adjust in the Q.  When a fader is disabled, it turns a solid pale pink.  You 
can also control-click the output name to re-activate any disabled faders. 
 
If you have a properly set-up Matrix Mirror, you can check the box marked 
Use Matrix Mirror and choose a companion Mixer Channel to the main 
channel set at the top level of the module.  Make adjustments for the Left 
side in the Live Matrix Q Mapper, and when the Q is activated, Cricket will 
automatically reflect these settings through the Matrix Mirror for the Right 
side.  This way you can use 1 Live Matrix Q Module to apply matrix 
settings/fades to both sides of a stereo signal. 
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Custom Fade Type (per Mixer Module) 

 
 
 
Prev and Next to Control Builder 

 
You can now build midi controls for Master Q List navigation in the Control 
Builder.  Prev and Next are built similarly to other midi controls and give 
you the ability to step forward or backwards through the Master Q List via 
remote midi control. 
 
Auto Cursor De-Select 
A new feature in the General Tab of the Preferences panel is Auto Cursor 
De-Select.  When this is turned on and Live Mode is enabled, Cricket will 
repeatedly clear all cursor fields at a rate set by you (between .1-60 
seconds).  Enable this if you are using spacebar or enter keys for Go!-ing 
to eliminate the chances for the cursor to get stuck in text fields (for 
instance, the Q Builder or Goto Q fields).  This can be especially useful 
during rehearsals or tech when you are moving back and forth between 
running Qs and adjusting them in the Q Builder/Editor.  The feature is 
disabled when Live Mode is turned off, so you can use Live Mode as a 
quick toggle when you need to edit Qs or otherwise linger in a text field.  
The settings for Auto Cursor De-Select are saved into a show file. 
 
 
Display of auth/key codes in About... window for authorized apps 
You can now view the Auth Code and associated Key Code for an 
authorized install of Cricket.  You will find these in the About Cricket… 
window found in the Cricket menu.   
 
Cricket will now create fresh Template folder & Default files when 
none are present 
When multiple users use Cricket on the same machine, Cricket will now 

A new 4th Fade Type has been added to the Mixer 
Q Module:  The Custom Fade Type.  Marked by a 
‘C’, this new fade type is user-defined per Mixer Q 
Module (one unique fade per module).  Select the 
custom fade by clicking on the ‘C’ fade type button.  
Control-click the ‘C’ to open up the fade editor.  
Here you can adjust the fade as you would adjust 
the fade types 1-3.  Note:  this fade type will apply 
to both sides (L+R) of the Mixer Q Module. 
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create a default set of Q Templates inside the Application Support folder 
and a fresh set of Default Show files inside the Cricket 2 Preferences 
Folder for each user.  Additionally, if you need to trash your preferences or 
templates, Cricket will create fresh sets upon the next startup of the app. 
 
Other Additions: 
New Map menu in menu bar 
Cancel button to quit dialog in demo mode 
 

New in v2.2.2: 
 
New Actions for the Deck Q Module 
In addition to Play, Stop, and Loop, the Deck Q Module now has 4 
additional actions:  Pause, Resume, Pitch, and Relay. 
 
Pause and Resume are the counterparts to each other and do exactly 
what you would expect:  Pause a deck, or Resume a paused deck.   
 
Pitch and Relay are designed to throw at a deck that is currently looping a 
track. Set the module to the same Deck as the looping one. Pick a new 
track, and arm it to Pitch.  When you take the Q, the deck will play out the 
remainder of the current loop, and upon its completion will seamlessly 
trigger the new track.  Relay works exactly the same as Pitch, except that it 
begins looping the new track instead of just playing it. 
 
Use Pitch and Relay to build a series of vamping Qs.  For Instance, when 
you want a piece of music to loop/vamp in one section until an action 
onstage occurs, before moving on musically to the next section. 
 
New Q Module:  Autokill 
The Autokill Q Module allows you to kill all Autosteps, Delays, Pitches, and 
Relays, similar to using the key command Option-Z. 
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